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Упражнение 1. Создание диаграммы вариантов использования
Постановка задачи

"Опять!" - сказал Боб, повесив телефонную трубку.
Мэри взглянула на него, оторвавшись от компьютера: "В чем дело?"
"Четвертый раз за этот месяц один из наших клиентов жалуется, что не получил своего заказа. Если так

будет продолжаться и дальше, мы вылетим из дела."
"Остынь", -- ответила Мэри - "Мы просто слишком быстро растем. Обработка всех заказов на бумаге

проходила прекрасно, когда наша компания состояла из пяти человек. Нельзя ожидать от нее такой работы
теперь. Давай поговорим со Сьюзан, может быть, мы сумеем спроектировать систему, которая поможет
нам управиться со всем этим."

Robertson's Cabinets, Inc.  - это маленькая компания, специализирующаяся на производстве стандартных
и нестандартных кухонных шкафов. Компания началась с небольшой группы собравшихся вместе
предпринимателей. Когда дело началось три года назад, поступало слишком мало заказов, и они вполне
могли управляться с ними на бумаге. С ростом их репутации число заказов возрастало. Пришлось нанять
новых рабочих, и за три года фирма выросла до магазина с более чем 50 сотрудниками.

Хотя это еще все-таки небольшая компания, но она выросла уже настолько, что уже не могла больше
полагаться на обработку заказов вручную. Владельцы фирмы Боб и Мэри Робертсоны решили поговорить
со Сьюзан, чтобы решить эту проблему. Сьюзан -- это одна из небольшого числа специалистов по
компьютерам, входящих в отделение этой фирмы, занимающееся информационными технологиями.

Боб пошел звонить Сьюзан.
"Совершенно очевидно, что нам требуется система по обработке заказов. Мы столкнулись с серьезным

риском потерять клиентов."
"Согласна."
"Можешь ты разработать программу на Java, которая отслеживала бы заказы?"
"Пока что не волнуйтесь по поводу реализации. Давайте решим, чего вы хотите от системы?"
"Надо, чтобы она отслеживала заказы."
"Не мог бы ты быть более конкретным? Давай рассмотрим нынешний процесс".
"Хорошо, получив звонок, мы заполняем форму заказа. Мы передаем ее Клинту в магазин, он заполняет

все необходимые документы и готовит отправку товара клиенту. Копию формы мы отдаем Дону в
бухгалтерию. Он вводит ее в бухгалтерскую систему и выписывает счет".

"И вы хотите, чтобы новая система поддерживала весь этот процесс?"
"Точно".
Из этого разговора Сьюзан смогла понять, что система должна обеспечивать возможность добавления

новых заказов, изменения старых, выполнения заказов, проверки и возобновления инвентарных описей.
При получении заказа система должна также послать сообщение бухгалтерской системе, которая
выписывает счет. Если требуемого товара нет на складе, заказ должен быть отклонен. Затем Сьюзан
преобразовала требования в диаграмму Вариантов Использования, с помощью которой начала
моделировать систему.

Создание диаграммы Вариантов Использования
Создайте диаграмму Вариантов Использования для системы обработки заказов. Требуемые для этого

действия подробно перечислены далее. Готовая диаграмма Вариантов Использования должна выглядеть
как на рисунке 1.
Этапы выполнения упражнения
Создать диаграммы Вариантов Использования, вариантов использования и Действующих лиц
1. Дважды щелкните на Главной диаграмме Вариантов Использования (Main) в броузере, чтобы открыть
ее.
2. С помощью кнопки Use Case (Вариант Использования) панели инструментов поместите на диаграмму
новый вариант использования.
3. Назовите этот новый вариант использования "Ввести новый заказ".
4. Повторите этапы 2 и 3, чтобы поместить на диаграмму остальные варианты использования: Изменить
существующий заказ, Напечатать инвентарную опись, Обновить инвентарную опись, Оформить заказ,
Отклонить заказ
5. С помощью кнопки Actor (Действующее лицо) панели инструментов поместите на диаграмму новое
действующее лицо.
6. Назовите его "Продавец"
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7. Повторите шаги 5 и 6, поместив на диаграмму остальных действующих лиц: Управляющий магазином,
Клерк магазина, Бухгалтерская система

Оформить заказ

Изменить сущест-
вующий заказ

Бухгалтерская система

Продавец

Ввести
новый заказ

Отклонить заказ

Клерк в
магазине

Обновить инвен-
тарную опись

Управляющий
магазином

Напечатать ин-
вентарную опись

<<extends>>

Рис. 1. Диаграмма Вариантов Использования для системы обработки заказов.
Указать абстрактные варианты использования
1. Щелкните правой кнопкой мыши на варианте использования "Отклонить заказ" на диаграмме.
2. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
3. Пометьте контрольный переключатель Abstract (Абстрактный), чтобы сделать этот вариант
использования абстрактным.
Добавить ассоциации
1. С помощью кнопки Unidirectional Association (Однонаправленная ассоциация) панели инструментов
нарисуйте ассоциацию между действующим лицом Продавец и вариантом использования "Ввести новый
заказ".
2. Повторите этот этап, чтобы поместить на диаграмму остальные ассоциации.
Добавить связь расширения
1. С помощью кнопки Generalization панели инструментов нарисуйте связь между вариантом
использования "Отклонить заказ" и вариантом использования "Оформить заказ". Стрелка должна
протянуться от первого варианта использования ко второму. Связь расширения означает, что вариант
использования "Отклонить заказ" при необходимости дополняет функциональные возможности варианта
использования "Оформить заказ".
2. Щелкните правой кнопкой мыши на новой связи между вариантами использования "Отклонить заказ" и
"Оформить заказ".
3. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
4. В раскрывающемся списке стереотипов введите слово extends (расширение), затем нажмите ОК.
5. Слово <<extends>> появится на линии данной связи.
Добавить описания к вариантам использования
1. Выделите в броузере вариант использования "Ввести новый заказ".
2. В окне документации введите следующее описание к этому варианту использования: Этот вариант
использования дает клиенту возможность ввести новый заказ в систему.
3. С помощью окна документации введите описания ко всем остальным вариантам использования.
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Добавить описания к действующему лицу
1. Выделите в броузере действующее лицо Продавец
2. В окне документации введите для этого действующего лица следующее описание: Продавец - это
служащий, доставляющий и старающийся продать продукцию.
3. С помощью окна документации введите описания к оставшимся действующим лицам.
Прикрепление файла к варианту использования
1. Для описания главного потока событий варианта использования "Ввести новый заказ" создайте файл
OrderFlow.doc, содержащий следующий текст:

1. Продавец выбирает пункт "Создать новый заказ" из имеющегося меню.
2. Система выводит форму "Подробности заказа".
3. Продавец вводит номер заказа, заказчика и то, что заказано.
4. Продавец сохраняет заказ.
5. Система создает новый заказ и сохраняет его в базе данных.

2. Щелкните правой кнопкой мыши на варианте использования "Ввести новый заказ".
3. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию)
4. Перейдите на вкладку файлов.
5. Щелкните правой кнопкой мыши на белом поле и из открывшегося меню выберите пункт Insert File
(Ввести файл).
6. Укажите файл OpenFlow.doc и нажмите на кнопку Open (Открыть), чтобы прикрепить файл к варианту
использования.

Упражнение 2. Создание диаграмм взаимодействия
В этом упражнении будут разработаны диаграммы Последовательности и Кооперативные диаграммы,

описывающие введение нового заказа в нашу систему обработки заказов.

Постановка задачи
Поговорив с Бобом, Сьюзан поняла, что должна делать система обработки заказов, разрабатываемая ей

для фирмы Robertson's Cabinets. Она нарисовала диаграмму Вариантов Использования. Изучив эту
диаграмму, все пришли к согласию по поводу области применения системы.

Теперь наступило время анализа ее составных частей. Высший приоритет среди пользователей имеет
вариант использования "Ввести новый заказ", он же связан с наибольшим риском. В связи с этим Сьюзан
решила заняться им в первую очередь.

Она поговорила с Карлом, заведующим отделом продаж. Они вдвоем обсудили поток событий, который
будет реализовываться в варианте использования.

Получив нужную ей информацию, Сьюзан засела за описание сценариев. В результате ее описание
выглядело следующим образом:

1. Продавец вводит новый заказ.
2. Продавец пытается ввести заказ, но товара нет на складе.
3. Продавец пытается ввести заказ, но при его сохранении в базе данных произошла ошибка.

Затем она приступила к созданию диаграмм Последовательности и Кооперативных диаграмм для
сценария "Ввести новый заказ".

Создание диаграмм Взаимодействия
Создайте диаграмму Последовательности и Кооперативную диаграмму, отражающую ввод нового заказа

в систему обработки заказов. Готовая диаграмма Последовательности должна выглядеть как на рисунке 5.
Это только одна из диаграмм, необходимых для моделирования варианта использования "Ввести новый

заказ". Она соответствует успешному варианту хода событий. Для описания того, что случится, если
возникнет ошибка, или если пользователь выберет другие действия из предложенных, придется
разработать другие диаграммы. Каждый альтернативный поток варианта использования может быть
промоделирован с помощью своих собственных диаграмм Взаимодействия.
Этапы выполнения упражнения
Настройка
1. В меню модели выберите пункт Tools > Options (Инструменты > Параметры).
2. Перейдите на вкладку диаграмм.
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3. Контрольные переключатели Sequence Numbering, Collaboration Numbering и Focus of Control должны
быть помечены.
4. Нажмите ОК, чтобы выйти из окна параметров.
Создание диаграммы Последовательности
1. Щелкните правой кнопкой мыши на Логическом представлении броузера.
2. В открывшемся меню выберите пункт New > Sequence Diagram.
3. Назовите новую диаграмму "Ввод заказа".
4. Дважды щелкните на ней, чтобы открыть ее.
Добавление на диаграмму действующего лица и объектов
1. Перетащите действующее лицо Продавец (Salesperson) с броузера на диаграмму.
2. На панели инструментов нажмите кнопку Object (Объект).
3. Щелкните мышью в верхней части диаграммы, чтобы поместить туда новый объект.
4. Назовите объект "Order Options Form -- Выбор варианта заказа".
5. Повторите этапы 3 и 4, чтобы поместить на диаграмму все остальные объекты:
# "Order Detail Form" -- Форма Детали заказа
# "Order N1234" -- Заказ №1234.
Добавление сообщений на диаграмму
1. На панели инструментов нажмите кнопку Object Message (Сообщение объекта).
2. Проведите мышью от линии жизни актера Продавец к линии жизни объекта Выбор варианта заказа.
3. Выделив сообщение, введите его имя "Create New Order" -- Создать новый заказ.
4. Повторите этапы 2 и 3, чтобы поместить на диаграмму дополнительные сообщения:

# Open form -- Открыть форму (между Выбором варианта заказа и Деталями заказа)
# Enter order number, customer, order items -- Ввести номер заказа, заказчика и число заказываемых
предметов (между Продавцом и Деталями заказа)
# Save the order -- Сохранить заказ (между Продавцом и Деталями заказа)
# Create new, blank order -- Создать пустой заказ (между Деталями заказа и Заказом №1234)
# Set the order number, customer, order items -- Ввести номер заказа, заказчика и число заказываемых
предметов (между Деталями заказа и Заказом №1234).
# Save the order -- Сохранить заказ (между Деталями заказа и Заказом №1234)

Мы завершили первый этап работы. Готовая диаграмма Последовательности представлена на рисунке 2.

Форма выбора
варианта заказа

Форма Детали
заказа Заказ №1234

1: Создать
новый заказ

3: Ввести номер заказа, заказчика и заказываемые предметы

Продавец

2: Открыть форму

5: Создать пустой заказ

4: Сохранить заказ

6: Задать номер заказа, заказчика и заказываемые предметы

7: Сохранить заказ

Рис. 2. Диаграмма Последовательности ввода нового заказа после завершения первого этапа работы.
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Теперь надо позаботиться об управляющих объектах и взаимодействии с базой данных. Как видно из

диаграммы, объект Детали заказа имеет множество ответственностей, с которыми лучше всего мог бы
справиться управляющий объект. Кроме того, новый заказ должен сохранять себя в базе данных сам.
Вероятно, эту обязанность лучше было бы переложить на другой объект.
Добавление на диаграмму дополнительных объектов
1. На панели инструментов нажмите кнопку Object.
2. Щелкните мышью между объектами Детали заказа и Заказ №1234, чтобы поместить туда новый объект.
3. Введите имя объекта - Order Manager (Управляющий заказами).
4. На панели инструментов нажмите кнопку Object.
5. Новый объект расположите справа от Заказа №1234.
6. Введите его имя - Transaction Manager (Управляющий транзакциями).
Назначение ответственностей объектам
1. Выделите сообщение 5 (Создать пустой заказ).
2. Нажмите комбинацию клавиш CTRL + D, чтобы удалить это сообщение.
3. Повторите этапы 1 и 2, чтобы удалить два последних сообщения:

# Вести номер заказа, заказчика и число заказываемых предметов
# Сохранить заказ

4. На панели инструментов нажмите кнопку Object Message.
5. Поместите на диаграмму новое сообщение, расположив его под сообщением 4 между Деталями заказа и
Управляющим заказами.
6. Назовите его Save the order (Сохранить заказ).

Форма выбора
варианта заказа

Форма Детали
заказа Заказ №1234

1: Создать
новый заказ

3: Ввести номер заказа, заказчика и заказываемые предметы

Продавец

Менеджер
заказов

2: Открыть форму

6: Создать пустой заказ

Менеджер
транзакций

4: Сохранить заказ

7: Задать номер заказа, заказчика и заказываемые предметы

8: Сохранить заказ

5: Сохранить заказ

9: Собрать информацию о заказе

10:Сохранить информацию о заказе в базе данных

Рис. 3. Диаграмма Последовательности с новыми объектами.
7. Повторите этапы 4 - 6, добавив сообщения с шестого по девятое и назвав их:

# Create new, blank order (Создать новый заказ) - между Управляющим заказами и Заказом №1234.
# Set the order number, customer, order items (Вести номер заказа, заказчика и число заказываемых
предметов) - между Управляющим заказами и Заказом №1234.
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# Save the order (Сохранить заказ) - между Управляющим заказами и Управляющим транзакциями.
# Collect order information (Информация о заказе) - между Управляющим транзакциями и Заказом
№1234.

8. На панели инструментов нажмите кнопку Message to Self (Сообщение себе).
9. Щелкните на линии жизни объекта Управляющий транзакциями ниже сообщения 9, добавив туда
рефлексивное сообщение. Назовите его Save the order information to the database (Сохранить информацию о
заказе в базе данных).

Теперь диаграмма Последовательности должна выглядеть как на рисунке 3.
Соотнесение объектов с классами
1. Щелкните правой кнопкой мыши на объекте Выбор варианта заказа.
2. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
3. В раскрывающемся списке классов выберите пункт <New> (Создать). Появится окно спецификации
классов.
4. В поле имени введите имя OrderOptions (Выбор заказа).
5. Щелкните на кнопке ОК. Вы вернетесь к окну спецификации объекта.
6. В списке классов выберите теперь класс OrderOptions.
7. Щелкните на кнопке ОК, чтобы вернуться к диаграмме. Теперь объект называется Order Options Form :
OrderOptions (Выбор варианта заказа : OrderOptions).
8. Для соотнесения остальных объектов с классами повторите этапы с 1 по 7:

# Класс OrderDetail соотнесите с объектом Детали заказа.
# Класс OrderMgr - с объектом Управляющий заказами.
# Класс Order - с объектом Заказ №1234.
# Класс TransactionMgr - с объектом Управляющий транзакциями.

После завершения этих действий ваша диаграмма должна выглядеть как на рисунке 4.

Форма выбора
варианта заказа:
ВыборЗаказа

Форма Детали
заказа:

ДеталиЗаказа
Заказ №1234:

Заказ

1: Создать
новый заказ

3: Ввести номер заказа, заказчика и заказываемые предметы

Продавец

Менеджер
заказов:

МенеджерЗаказов

2: Открыть форму

6: Создать пустой заказ

Менеджер
транзакций:
Менеджер
транзакций

4: Сохранить заказ

7: Задать номер заказа, заказчика и заказываемые предметы

8: Сохранить заказ

5: Сохранить заказ

9: Собрать информацию о заказе

10:Сохранить информацию о заказе в базе данных

Рис. 4. Диаграмма Последовательности с именами классов.
Соотнесение сообщений с операциями
1. Щелкните правой кнопкой на сообщении 1, Создать новый заказ.
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2. В открывшемся меню выберите пункт <new operation> (создать операцию). Появится окно
спецификации операции.
3. В поле имени введите имя операции - Create (Создать).
4. Нажмите на кнопку ОК, чтобы закрыть окно спецификации операции и вернуться на диаграмму.
5. Еще раз щелкните правой кнопкой мыши на сообщении 1.
6. В открывшемся меню выберите новую операцию Create().
7. Повторите сообщения с 1 по 6, пока не соотнесете с операциями все остальные сообщения:

# Сообщение 2:Открыть соотнесите с операцией Open()
# Сообщение 3: Ввести номер заказа, заказчика и число заказываемых предметов - с операцией
SubmitInfo().
# Сообщение 4:Сохранить заказ - с операцией Save().
# Сообщение 5:Сохранить заказ - с операцией SaveOrder().
# Сообщение 6:Создать пустой заказ - с операцией Create().
# Сообщение 7: Ввести номер заказа, заказчика и число заказываемых предметов - с операцией
SetInfo().
# Сообщение 8:Сохранить заказ - с операцией SaveOrder().
# Сообщение 9:Информация о заказе - с операцией GetInfo().
# Сообщение 10:Сохранить информацию о заказе в базе данных - с операцией Commit.

Ваша диаграмма должна выглядеть как на рисунке 5.

Форма выбора
варианта заказа:
ВыборЗаказа

Форма Детали
заказа:

ДеталиЗаказа
Заказ №1234:

Заказ

1: Create()

3: SubmitInfo()

Продавец

Менеджер
заказов:

МенеджерЗаказов

2: Open()

6: Create()

Менеджер
транзакций:
Менеджер
транзакций

4: Save()

7: SetInfo()

8: SaveOrder()

5: SaveOrder()

9: GetInfo()

10: Commit()

Рис. 5. Диаграмма Последовательности с показанными на ней операциями.
Создание Кооперативной диаграммы

Для создания Кооперативной диаграммы достаточно просто нажать клавишу F5 или, если вы хоти сами
проделать все требуемые операции, воспользуйтесь приводимым далее планом.
1. Щелкните правой кнопкой мыши на Логическом представлении в броузере.
2. В открывшемся меню выберите пункт New > Collaboration Diagram.
3. Назовите эту диаграмму Ввод заказа.
4. Щелкните на ней дважды, чтобы открыть ее.
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Добавление действующего лица и объектов на диаграмму
1. Перетащите действующее лицо Продавец (Salesperson) с броузера на диаграмму.
2. На панели инструментов нажмите кнопку Object (Объект).
3. Щелкните мышью где-нибудь внутри диаграммы, чтобы поместить туда новый объект.
4. Назовите объект "Order Options Form" -- Выбор варианта заказа.
5. Повторите этапы 3 и 4, чтобы поместить на диаграмму все остальные объекты:

# "Order Detail Form" -- Форма Детали заказа
# "Order N1234" -- Заказ №1234.

Добавление сообщений на диаграмму
1. На панели инструментов нажмите кнопку Object Link (Связь объекта).
2. Проведите мышью от действующего лица Продавец к объекту Выбор варианта заказа.
3. Повторите этапы 1 и 2, соединив связями следующие объекты:

# Действующее лицо Продавец и объект Детали Заказа.
# Объект Выбор варианта заказа и объект Детали заказа.
# Объект Детали заказа и объект Заказ №1234.

4. На панели инструментов нажмите кнопку Link Message (Сообщение связи).
5. Щелкните на связи между Продавцом и Выбором варианта заказа.
6. Выделив сообщение, введите его имя "Create New Order -- Создать новый заказ".
7. Повторите этапы с 4 по 6, поместив на диаграмму все остальные сообщения, как показано ниже:

# Open form -- Открыть форму (между Выбором варианта заказа и Деталями заказа)
# Enter order number, customer, order items -- Ввести номер заказа, заказчика и число заказываемых
предметов (между Продавцом и Деталями заказа)
# Save the order -- Сохранить заказ (между Продавцом и Деталями заказа)
# Create new, blank order -- Создать пустой заказ (между Деталями заказа и Заказом №1234)
# Set the order number, customer, order items -- Ввести номер заказа, заказчика и число заказываемых
предметов (между Деталями заказа и Заказом №1234).
# Save the order -- Сохранить заказ (между Деталями заказа и Заказом №1234)

Теперь, как и раньше, надо продолжить работу и поместить на диаграмму дополнительные элементы, а
также рассмотреть ответственности объектов.
Добавление на диаграмму дополнительных объектов
1. На панели инструментов нажмите кнопку Object.
2. Щелкните мышью где-нибудь на диаграмме, чтобы поместить туда новый объект.
3. Введите имя объекта - Order Manager (Управляющий заказами).
4. На панели инструментов нажмите кнопку Object.
5. Поместите на диаграмму еще один объект.
6. Введите его имя - Transaction Manager (Управляющий транзакциями).
Назначение ответственностей объектам
1. Выделите сообщение 5 (Создать пустой заказ). Выделяйте слова, а не стрелку.
2. Нажмите комбинацию клавиш CTRL + D, чтобы удалить это сообщение.
3. Повторите этапы 1 и 2, чтобы удалить сообщения 6 и 7:

# Вести номер заказа, заказчика и число заказываемых предметов
# Сохранить заказ

4. Выделите связь между объектами Детали заказа и Заказ №1234.
5. Нажмите комбинацию клавиш CTRL + D, чтобы удалить эту связь.
6. На панели инструментов нажмите кнопку Object Link (Связь объекта).
7. Нарисуйте связь между Деталями Заказа и Управляющим заказами.
8. На панели инструментов нажмите кнопку Object Link (Связь объекта).
9. Нарисуйте связь между Управляющим заказами и Заказом №1234.
10. На панели инструментов нажмите кнопку Object Link (Связь объекта).
11. Нарисуйте связь между Заказом №1234 и Управляющим транзакций.
12. На панели инструментов нажмите кнопку Object Link (Связь объекта).
13. Нарисуйте связь между Управляющим заказами и Управляющим транзакций.
14. На панели инструментов нажмите кнопку Link Message (Сообщение связи).
15. Щелкните на связи между объектами Детали заказа и Управляющим заказами, чтобы ввести новое
сообщение.
16. Назовите это сообщение Save the order (Сохранить заказ).
17. Повторите этапы 14 - 16, добавив сообщения с шестого по девятое и назвав их:
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# Create new, blank order (Создать новый заказ) - между Управляющим заказами и Заказом №1234.
# Set the order number, customer, order items (Вести номер заказа, заказчика и число заказываемых
предметов) - между Управляющим заказами и Заказом №1234.
# Save the order (Сохранить заказ) - между Управляющим заказами и Управляющим транзакциями.
# Collect order information (Информация о заказе) - между Управляющим транзакциями и Заказом
№1234.

18. На панели инструментов нажмите кнопку Message to Self (Сообщение себе).
19. Щелкните на объекте Управляющий транзакциями, добавив к нему рефлексивное сообщение.
20. На панели инструментов нажмите кнопку Link Message (Сообщение связи).
21. Щелкните на рефлексивной связи Управляющего транзакциями, чтобы ввести туда сообщение.
22. Назовите новое сообщение Save the order information to the database (Сохранить информацию о заказе в
базе данных).
Соотнесение объектов с классами (если при разработке описанной выше диаграммы Последовательности
сами классы вы уже создали)
1. Найдите в броузере класс OrderOptions.
2. Перетащите его на объект Выбор варианта заказа на диаграмме.
3. Повторите этапы 1 и 2, соотнеся остальные объекты и соответствующие им классы:

# Класс OrderDetail соотнесите с объектом Детали заказа.
# Класс OrderMgr - с объектом Управляющий заказами.
# Класс Order - с объектом Заказ №1234.
# Класс TransactionMgr - с объектом Управляющий транзакциями.

Соотнесение объектов с классами (если вы не создавали описанную выше диаграмму
Последовательности)
1. Щелкните правой кнопкой мыши на объекте Выбор варианта заказа.
2. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
3. В раскрывающемся списке классов выберите пункт <New> (Создать). Появится окно спецификации
классов.
4. В поле имени введите имя OrderOptions (Выбор заказа).
5. Щелкните на кнопке ОК. Вы вернетесь к окну спецификации объекта.
6. В списке классов выберите теперь класс OrderOptions.
7. Щелкните на кнопке ОК, чтобы вернуться к диаграмме. Теперь объект называется Order Options Form :
OrderOptions (Выбор варианта заказа : OrderOptions).
8. Для соотнесения остальных объектов с классами повторите этапы с 1 по 7:

# Класс OrderDetail соотнесите с объектом Детали заказа.
# Класс OrderMgr - с объектом Управляющий заказами.
# Класс Order - с объектом Заказ №1234.
# Класс TransactionMgr - с объектом Управляющий транзакциями.

Соотнесение сообщений с операциями (если при разработке описанной выше диаграммы
Последовательности сами операции вы уже создали)
1. Щелкните правой кнопкой на сообщении 1, Создать новый заказ.
2. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
3. В раскрывающемся списке имен укажите имя операции - Create (Создать).
4. Нажмите на кнопку ОК.
5. Повторите этапы с первого по четвертый для соотнесения с операциями остальных сообщений:

# Сообщение 2:Открыть соотнесите с операцией Open()
# Сообщение 3: Ввести номер заказа, заказчика и число заказываемых предметов - с операцией
SubmitInfo().
# Сообщение 4:Сохранить заказ - с операцией Save().
# Сообщение 5:Сохранить заказ - с операцией SaveOrder().
# Сообщение 6:Создать пустой заказ - с операцией Create().
# Сообщение 7: Ввести номер заказа, заказчика и число заказываемых предметов - с операцией
SetInfo().
# Сообщение 8:Сохранить заказ - с операцией SaveOrder().
# Сообщение 9:Информация о заказе - с операцией GetInfo().
# Сообщение 10:Сохранить информацию о заказе в базе данных - с операцией Commit().

Соотнесение сообщений с операциями (если вы не создавали описанную выше диаграмму
Последовательности)
1. Щелкните правой кнопкой на сообщении 1, Создать новый заказ.
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2. В открывшемся меню выберите пункт <new operation> (создать операцию). Появится окно
спецификации операции.
3. В поле имени введите имя операции - Create (Создать).
4. Нажмите на кнопку ОК, чтобы закрыть окно спецификации операции и вернуться на диаграмму.
5. Еще раз щелкните правой кнопкой мыши на сообщении 1.
6. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
7. В раскрывающемся списке Name (имя) укажите имя новой операции.
8. Нажмите на кнопку ОК.
9. Повторите этапы с первого по восьмой, чтобы создать новые операции и соотнести с ними остальные
сообщения:

# Сообщение 2:Открыть соотнесите с операцией Open()
# Сообщение 3: Ввести номер заказа, заказчика и число заказываемых предметов - с операцией
SubmitInfo().
# Сообщение 4:Сохранить заказ - с операцией Save().
# Сообщение 5:Сохранить заказ - с операцией SaveOrder().
# Сообщение 6:Создать пустой заказ - с операцией Create().
# Сообщение 7: Ввести номер заказа, заказчика и число заказываемых предметов - с операцией
SetInfo().
# Сообщение 8:Сохранить заказ - с операцией SaveOrder().
# Сообщение 9:Информация о заказе - с операцией GetInfo().
# Сообщение 10:Сохранить информацию о заказе в базе данных - с операцией Commit.

Ваша диаграмма должна выглядеть как на рисунке 6.

Рис. 6. Кооперативная диаграмма с показанными на ней операциями.

Упражнение 3. Создание диаграмм классов
В этом упражнении надо будет сгруппировать в пакеты классы, созданные во время выполнения

предыдущего упражнения. Затем вам предстоит создать несколько диаграмм Классов, на которых вы также
покажете классы и пакеты системы.
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Постановка задачи
Изучив диаграммы Взаимодействия, Боб понял, что система соответствует деловым потребностям

компании. После этого Сьюзан пришла к руководителю группы разработчиков Карен:
"Вот диаграммы Взаимодействия, описывающие процесс ввода нового заказа".
"Прекрасно. Приступаем к разработке".
Карен взглянула на классы модели Rose. Она решила объединить их в пакеты по стереотипу. Она

создала пакеты Entities (Сущности), Boundaries (Границы) и Control (Управление), поместив в них
соответствующие классы. Затем для каждого пакета были созданы диаграммы Классов; кроме того, на
Главной диаграмме были показаны пакеты и на диаграмме Ввода нового заказа -- все классы этого
варианта использования.

Создание диаграммы Классов
Объедините обнаруженные нами классы в пакеты. Создайте диаграмму Классов для отображения

пакетов, диаграммы Классов для представления классов в каждом пакете и диаграмму Классов для
представления всех классов варианта использования "Ввести новый заказ".
Этапы выполнения упражнения
Настройка
1. В меню модели выберите пункт Tools > Options (Инструменты > Параметры).
2. Перейдите на вкладку диаграмм.
3. Убедитесь, что помечен контрольный переключатель Show Stereotypes (Показать стереотипы).
4. Убедитесь, что помечены контрольные переключатели Show All Attributes (Показать все атрибуты) и
Show All Operations (Показать все операции).
5. Убедитесь, что не помечены переключатели Suppress Attributes (Подавить вывод атрибутов) и Suppress
Operations (Подавить вывод операций).
Создание пакетов
1. Щелкните правой кнопкой мыши на Логическом представлении броузера.
2. В открывшемся меню выберите пункт New > Package (Создать > пакет).
3. Назовите новый пакет Entities (Сущности).
4. Повторите этапы с первого по третий, создав пакеты Boundaries (границы) и Control (управление).

Границы

Сущности

Управление

Рис. 7. Главная диаграмма Классов системы обработки заказов.
Создание Главной диаграммы Классов
1. Дважды щелкните на Главной диаграмме Классов прямо под Логическим представлением броузера,
чтобы открыть ее.
2. Перетащите пакет Entities из броузера на диаграмму.
3. Перетащите пакеты Boundaries и Control из броузера на диаграмму.
Главная диаграмма Классов должна выглядеть как на рисунке 7.
Создание диаграммы Классов для сценария "Ввести новый заказ" со всеми классами.
1. Щелкните правой кнопкой мыши на Логическом представлении броузера.
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2. В открывшемся меню выберите пункт New > Class Diagram (Создать > Диаграмму Классов).
3. Назовите новую диаграмму Классов Add New Order (Введение нового заказа).
4. Щелкните в броузере на этой диаграмме дважды, чтобы открыть ее.
5. Перетащите из броузера все классы (OrderOptions, OrderDetail, Order, OrderMgr и TransactionMgr).

Диаграмма Классов должна выглядеть как на рисунке 8.

ВыборЗаказа

Create()

МенеджерЗаказов

SaveOrder()

ДеталиЗаказа

Open()
SubmitInfo()
Save()

Заказ

Сreate()
SetInfo()
GetInfo()

МенеджерТранзакций

SaveOrder()
Commit()

Рис. 8. Диаграмма Классов Add New Order.
Добавление стереотипов к классам
1. Щелкните правой кнопкой мыши на классе OrderOptions диаграммы.
2. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
3. В поле стереотипа введите слово Boundary.
4. Нажмите на кнопку ОК.
5. Щелкните правой кнопкой мыши на классе OrderDetail диаграммы.
6. В открывшемся меню выберите пункт Open Specification (Открыть спецификацию).
7. В раскрывающемся списке в поле стереотипов теперь будет стереотип Boundary. Укажите его.
8. Нажмите на кнопку ОК.
9. Повторите этапы 1 - 4, связав классы OrderMgr и TransactionMgr со стереотипом Control, а класс Order -
со стереотипом Entity.

Теперь диаграмма Классов должна выглядеть как на рисунке 9.
Объединение классов в пакеты
1. Перетащите в броузере класс OrderOptions на пакет Boundaries.
2. Перетащите класс OrderDetail на пакет Boundaries.
3. Перетащите классы OrderMgr и TransactionMgr на пакет Control.
4. Перетащите класс Order на пакет Entities.
Добавление диаграмм Классов к каждому пакету
1. Щелкните правой кнопкой на пакете Boundaries броузера.
2. В открывшемся меню выберите пункт New > Class Diagram (Создать > Диаграмму Классов).
3. Введите имя новой диаграммы - Main (Главная).
4. Дважды щелкните мышью на этой диаграмме, чтобы открыть ее.
5. Перетащите на нее из броузера классы OrderOptions и OrderDetail.
6. Закройте диаграмму.
7. Щелкните правой кнопкой на пакете Entities броузера.



15
8. В открывшемся меню выберите пункт New > Class Diagram (Создать > Диаграмму Классов).
9. Введите имя новой диаграммы - Main (Главная).
10. Дважды щелкните мышью на этой диаграмме, чтобы открыть ее.
11. Перетащите на нее из броузера класс Order.
12. Закройте диаграмму.
13. Щелкните правой кнопкой на пакете Control броузера.
14. В открывшемся меню выберите пункт New > Class Diagram (Создать >
15. Диаграмму Классов).
16. Введите имя новой диаграммы - Main (Главная).
17. Дважды щелкните мышью на этой диаграмме, чтобы открыть ее.
18. Перетащите на нее из броузера классы OrderMgr и TransactionMgr.
19. Закройте диаграмму.

<<Граница>>
ВыборЗаказа

Create()

<<Управление>>
МенеджерЗаказов

SaveOrder()

<<Граница>>
ДеталиЗаказа

Open()
SubmitInfo()
Save()

<<Сущность>>
Заказ

Сreate()
SetInfo()
GetInfo()

<<Управление>>
МенеджерТранзакций

SaveOrder()
Commit()

Рис. 9. Стереотипы классов для варианта использования Ввести новый заказ.

Упражнение 4. Создание диаграмм классов (учет новых требований)
В упражнении 2 было создано несколько операций для классов нашей задачи. В предыдущем

упражнении мы нанесли классы на диаграмму. В этом упражнении к описаниям операций будут добавлены
детали, включая параметры и типы возвращаемых значений. Кроме того, у классов будут определены
атрибуты.
Постановка задачи

После того, как Карен разработала диаграмму Классов для варианта использования "Ввести новый
заказ", она начала заполнять ее подробностями. В качестве языка программирования был выбран С++, что
позволило добавить к классам параметры операций, типы данных и типы возвращаемых значений.

Для определения атрибутов Карен вновь обратилась к потоку событий. В результате, к классу Order
диаграммы Классов были добавлены атрибуты Order Number (номер заказа) и Customer Name (Имя
клиента). Она просмотрела также список заказываемых товаров. Так как в одном заказе можно указать
большое количество товаров, и у каждого из них имеются свои собственные данные и поведение, Карен
решила моделировать их как самостоятельные классы, а не как атрибуты класса Order.

Чтобы привести модель в соответствие с новыми идеями, пришлось обновить диаграмму
Последовательностей, как показано на рисунке 10.
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Форма выбора
варианта заказа:
ВыборЗаказа

Форма Детали
заказа:

ДеталиЗаказа

Заказ №1234:
Заказ

1: Create()

3: SubmitInfo()

Продавец

Менеджер
заказов:

МенеджерЗаказов

2: Open()

6: Create()

Менеджер
транзакций:
Менеджер
транзакций

4: Save()

7: SetInfo()

10: SaveOrder()

5: SaveOrder()

11: GetInfo()

13: Commit()

Компект
мебели:

ПозицияЗаказа

8: Create()

9: SetInfo()

12: GetInfo()

Рис. 10. Обновленная диаграмма Последовательностей.

В этот момент Боб решил изменить требования:
"Нам надо отслеживать дату заказа и дату его выполнения. Кроме того, так как у нас появились новые

поставщики, слегка изменилась процедура инвентаризации."
Сначала Карен документировала новые требования относительно дат и рассмотрела изменения в

процедуре инвентаризации "на высоком уровне". Поскольку в данный момент она работала над вариантом
использования "Ввести новый заказ", ее больше всего интересовало, как эти процедурные изменения
повлияют на данный вариант использования. Работа с вариантом использования "Провести
инвентаризацию" была запланирована на следующий месяц, тогда она и позаботится о деталях
соответствующих процедур. Оказалось, что, хотя они чрезвычайно сильно повлияют на вариант
использования "Провести инвентаризацию", но совсем не отразятся на варианте использования "Ввести
новый заказ".

Новые требования, связанные с датами, привели к необходимости ввести пару новых атрибутов в класс
Order. После этого модель опять стала соответствовать последним предъявленным к системе требованиям.
Добавление атрибутов и операций

Добавим атрибуты и операции к классам диаграммы Классов "Ввести новый заказ". Для атрибутов и
операций используем специфические для языка особенности. Установим параметры так, чтобы показывать
все атрибуты, все операции и их сигнатуры. Видимость покажем с помощью нотации UML.
Этапы выполнения упражнения
Настройка
1. В меню модели выберите пункт Tools > Options.
2. Перейдите на вкладку Diagram.
3. Убедитесь, что переключатель Show Visibility помечен.
4. Убедитесь, что переключатель Show Stereotypes помечен.
5. Убедитесь, что переключатель Show Operation Signatures помечен.
6. Убедитесь, что переключатели Show All Attributes и Show All Operations помечены.
7. Убедитесь, что переключатели Suppress Attributes и Suppress Operations не помечены.
8. Перейдите на вкладку Notation.
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9. Убедитесь, что переключатель Visibility as Icons не помечен.
Добавление нового класса
1. Найдите в броузере диаграмму Классов варианта использования "Ввести новый заказ".
2. Щелкните на ней дважды, чтобы ее открыть.
3. Нажмите кнопку Class панели инструментов.
4. Щелкните мышью внутри диаграммы, чтобы поместить там новый класс.
5. Назовите его OrderItem (ПозицияЗаказа).
6. Назначьте этому классу стереотип Entity.
7. В броузере перетащите класс в пакет Entities.
Добавление атрибутов
1. Щелкните правой кнопкой мыши на классе Order (Заказ).
2. В открывшемся меню выберите пункт New Attribute (Создать атрибут).
3. Введите новый атрибут OrderNumber : Integer (НомерЗаказа)
4. Нажмите клавишу Enter.
5. Введите следующий атрибут CustomerName : String (НаименованиеЗаказчика).
6. Повторите этапы 4 и 5, добавив атрибуты OrderDate : Date (ДатаЗаказа) и OrderFillDate : Date
(ДатаЗаполненияЗаказа).
7. Щелкните правой кнопкой мыши на классе OrderItem.
8. В открывшемся меню выберите пункт New Attribute (Создать атрибут).
9. Введите новый атрибут ItemID : Integer (ИдентификаторПредмета).
10. Нажмите клавишу Enter.
11. Введите следующий атрибут ItemDescription : String (ОписаниеПредмета).
Добавление операций к классу OrderItem
1. Щелкните правой кнопкой мыши на классе OrderItem.
2. В открывшемся меню выберите пункт New Operation (Создать операцию).
3. Введите новую операцию Create.
4. Нажмите клавишу Enter.
5. Введите следующую операцию SetInfo
6. Нажмите клавишу Enter.
7. Введите следующую операцию GetInfo.
Подробное описание операций с помощью диаграммы Классов
1. Щелкните мышью на классе Order, выделив его таким способом.
2. Щелкните на этом классе еще один раз, чтобы переместить курсор внутрь.
3. Отредактируйте операцию Create(), чтобы она выглядела следующим образом: Create() : Boolean
4. Отредактируйте операцию SetInfo(), чтобы она выглядела следующим образом: SetInfo(OrderNum :
Integer, Customer : String, OrderDate : Date, FillDate : Date) : Boolean
5. Отредактируйте операцию GetInfo(), чтобы она выглядела следующим образом: GetInfo() : String
Подробное описание операций с помощью броузера
1. Найдите в броузере класс OrderItem.
2. Чтобы раскрыть этот класс, щелкните на значке "+" рядом с ним. В броузере появятся его атрибуты и
операции.
3. Дважды щелкните на операции GetIInfo(), чтобы открыть окно ее спецификации.
4. В раскрывающемся списке Return class (возвращаемый класс) укажите String.
5. Щелкните на кнопке ОК, закрыв окно спецификации операции.
6. Дважды щелкните в броузере на операции SetInfo класса OrderItem, чтобы открыть окно ее
спецификации.
7. В раскрывающемся списке Return class укажите Boolean.
8. Перейдите на вкладку Detail (Подробно).
9. Щелкните правой кнопкой мыши на белом поле в области аргументов, чтобы добавить туда новый
параметр.
10. В открывшемся меню выберите пункт Insert. Rose добавит туда аргумент под названием argname.
11. Щелкните один раз на этом слове, чтобы выделить его, и измените имя аргумента на ID.
12. Щелкните на колонке Type, открыв раскрывающийся список типов. В нем выберите тип Integer.
13. Щелкните на колонке Default, чтобы добавить значение аргумента по умолчанию. Введите туда число 0.
14. Нажмите на кнопку ОК, закрыв окно спецификации операции.
15. Дважды щелкните на операции Create() класса OrderItem, чтобы открыть окно ее спецификации.
16. В раскрывающемся списке Return class укажите Boolean.
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17. Нажмите на кнопку ОК, закрыв окно спецификации операции.
Подробное описание операций с помощью любого из описанных методов
1. Используя броузер или диаграмму Классов, введите следующую сигнатуру операций класса OrderDetail:

Open() : Boolean
SubmitInfo() : Boolean
Save() : Boolean

2. Используя броузер или диаграмму Классов, введите следующую сигнатуру операций класса
OrderOptions:

Create() : Boolean
3. Используя броузер или диаграмму Классов, введите следующую сигнатуру операций класса OrderMgr:

SaveOrder(OrderID : Integer) : Boolean
4. Используя броузер или диаграмму Классов, введите следующую сигнатуру операций класса
TransactionMgr:

SaveOrder(OrderID : Integer) : Boolean
Commit() : Integer

Упражнение 5. Создание диаграмм классов (добавление связей между классами)
В этом упражнении будут определены связи между классами, участвующими в варианте использования

"Ввести новый заказ".
Постановка задачи

После добавления к классам атрибутов и операций Карен была уже почти готова к генерации кода.
Сначала, однако, она должна была изучить связи между классами.

Чтобы найти связи, Карен изучила диаграммы Последовательности. Все взаимодействующие там классы
нуждались в определении соответствующих связей на диаграммах Классов. После обнаружения связей
Карен добавила их в модель.

Добавление связей
Добавим связи к классам, принимающим участие в варианте использования "Ввести новый заказ".

Этапы выполнения упражнения
Настройка
1. Найдите в броузере диаграмму Классов "Ввод нового заказа"
2. Дважды щелкните на ней, чтобы открыть ее.
3. Проверьте, имеется ли на панели инструментов диаграммы кнопка Unidirectional Association. Если ее
нет, продолжайте настройку, выполнив этапы 4 и 5. Если есть, приступайте к выполнению самого
упражнения.
4. Щелкните правой кнопкой мыши на панели инструментов диаграммы и в открывшемся меню выберите
пункт Customize.
5. Добавьте на панель кнопку, называющуюся Create A Unidirectional Association.
Добавление ассоциаций
1. Нажмите кнопку панели инструментов Unidirectional Association.
2. Нарисуйте ассоциацию от класса ВыборЗаказа (OrderOptions) к классу ДеталиЗаказа (OrderDetail).
3. Повторите этапы 1 и 2, создав еще ассоциации:

# От класса OrderDetail к классу МенеджерЗаказов (OrderMgr)
# От класса OrderMgr к классу Заказ (Order)
# От класса OrderMgr к классу МенеджерТранзакций (TransactionMgr)
# От класса TransactionMgr к классу Order
# От класса TransactionMgr к классу ПозицияЗаказа (OrderItem)
# От класса Order к классу OrderItem

4. Щелкните правой кнопкой мыши на однонаправленной ассоциации между классами OrderOptions и
OrderDetail, со стороны класса OrderOptions.
5. В открывшемся меню выберите пункт Multiplicity > Zero or One.
6. Щелкните правой кнопкой мыши на другом конце однонаправленной ассоциации.
7. В открывшемся меню выберите пункт Multiplicity > Zero or One.
8. Повторите этапы 4 - 7, добавив на диаграмму значения множественности для остальных ассоциаций, как
показано на рисунке 11.
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Рис. 11. Ассоциации сценария "Ввести новый заказ".

Упражнение 6. Создание диаграммы состояний
В этом упражнении будет создана диаграмма Состояний для класса Order.

Постановка задачи
Проектируя класс Order, Карен поняла, что за поведением этого класса надо наблюдать. Многие

требования к классу значительно изменялись при изменении состояния его экземпляра. Например, заказы,
выполнение которых было приостановлено, вели себя не так, как выполненные заказы, а те, в свою
очередь, не так, как отмененные заказы.

Чтобы убедиться, что проект удовлетворяет всем этим требованиям, Карен со своей группой
разработчиков создала диаграмму Состояний для класса Order. С помощью этой диаграммы разработчики
смогли окончательно понять, как надо писать код для этого класса.
Создание диаграммы Состояний

Разработайте диаграмму Состояний для класса Order, показанную на рисунке 12.
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Инициализация
entry: Сохранить дату заказа
do: Собрать клиентскую информацию
do: Добавить к заказу новые позиции

Выполнение заказа
отложено

Отменен

exit: Сохранить дату отмены

H

Отменить заказ

Выполнить заказ

Добавить к заказу новую позицию
 [Не осталось незаполненных позиций]

H

Выполнен

do: Выписать счет

Добавить к заказу новую позицию [остаются незаполненные позиции]

Рис. 12. Диаграмма Состояний для класса Order.
Этапы выполнения упражнения
Создание диаграммы
1. Найдите в броузере класс Order.
2. Щелкните на классе правой кнопкой мыши и в открывшемся меню укажите пункт Open State Diagram.
Добавление начального и конечного состояний
1. На панели инструментов нажмите кнопку Start State (Начальное состояние).
2. Поместите это состояние на диаграмму.
3. На панели инструментов нажмите кнопку End State (Конечное состояние).
4. Поместите это состояние на диаграмму.
Добавление суперсостояния
1. На панели инструментов нажмите кнопку State (Состояние).
2. Поместите это состояние на диаграмму.
Добавление оставшихся состояний
1. На панели инструментов нажмите кнопку State (Состояние).
2. Поместите это состояние на диаграмму.
3. Назовите состояние Cancelled (Отменен).
4. На панели инструментов нажмите кнопку State (Состояние).
5. Поместите это состояние на диаграмму.
6. Назовите состояние Filled (Выполнен).
7. На панели инструментов нажмите кнопку State (Состояние).
8. Поместите это состояние на диаграмму внутрь суперсостояния.
9. Назовите состояние Initialization (Инициализация).
10. На панели инструментов нажмите кнопку State (Состояние).
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11. Поместите это состояние на диаграмму внутрь суперсостояния.
12. Назовите состояние Pending (Выполнение заказа приостановлено).
Подробное описание состояний
1. Дважды щелкните на состоянии Initialization (Инициализация).
2. Щелкните правой кнопкой мыши на окне Actions (Действия).
3. В открывшемся меню выберите пункт Insert (Вставить).
4. Дважды щелкните мышью на новом действии.
5. Назовите его Store Order Date (Сохранить дату заказа).
6. Убедитесь, что в окне When (Когда) указан пункт On Entry (На входе).
7. Повторите этапы 3 - 7, добавив следующие действия:

# Collect Customer Info (Собрать клиентскую информацию), в окне When указать пункт Do
# Add Order Items (Добавить к заказу новые графы), в окне When указать Do

8. Нажмите на кнопки ОК два раза, чтобы закрыть спецификацию.
9. Дважды щелкните на состоянии Cancelled (Отменен).
10. Повторите этапы 2 - 7, добавив действие  Store Cancellation Data (Сохранить дату отмены), указать пункт
On Exit (на выходе)
11. Нажмите на кнопки ОК два раза, чтобы закрыть спецификацию.
12. Дважды щелкните на состоянии Filled (Выполнен).
13. Повторите этапы 2 - 7, добавив действие  Bill Customer (Выписать счет), указать пункт Do.
14. Нажмите на кнопки ОК два раза, чтобы закрыть спецификацию.
Добавление переходов
1. На панели инструментов нажмите кнопку Transition (Переход).
2. Щелкните мышью на начальном состоянии.
3. Проведите линию перехода к состоянию Initialization (Инициализация).
4. Повторите этапы с первого по третий, создав следующие переходы:

# От состояния Initialization (Инициализация) к состоянию Pending (Выполнение заказа
приостановлено)
# От состояния Pending (Выполнение заказа приостановлено) к состоянию Filled (Выполнен)
# От суперсостояния к состоянию Cancelled (Отменен)
# От состояния Cancelled (Отменен) к конечному состоянию
# От состояния Filled (Выполнен) к конечному состоянию

5. На панели инструментов нажмите кнопку Transition to Self (Переход к себе).
6. Щелкните на состоянии Pending (Выполнение заказа приостановлено).
Подробное описание переходов
1. Дважды щелкните на переходе от состояния Initialization (Инициализация) к состоянию Pending
(Выполнение заказа приостановлено), открыв окно его спецификации.
2. В поле Event (Событие) введите фразу Finalize order (Выполнить заказ).
3. Щелкните на кнопке ОК, закрыв окно спецификации.
4. Повторите этапы с первого по третий, добавив событие Cancel Order (Отменить заказ) к переходу между
суперсостоянием и состоянием Cancelled (Отменен).
5. Дважды щелкните на переходе от состояния Pending (Выполнение заказа приостановлено) к состоянию
Filled (Выполнен), открыв окно его спецификации.
6. В поле Event (Событие) введите фразу Add Order Item (Добавить к заказу новую позицию).
7. Перейдите на вкладку Detail (Подробно).
8. В поле Condition (Условие) введите No unfilled items remaining (Не осталось незаполненных позиций).
9. Щелкните на кнопке ОК, закрыв окно спецификации.
10. Дважды щелкните мышью на рефлексивном переходе (Transition to Self) состояния Pending
(Выполнение заказа приостановлено).
11. В поле Event (Событие) введите фразу Add Order Item (Добавить к заказу новую позицию).
12. Перейдите на вкладку Detail (Подробно).
13. В поле Condition (Условие) введите Unfilled items remaining (Остаются незаполненные позиции).
14. Щелкните на кнопке ОК, закрыв окно спецификации.

Упражнение 7. Создание диаграммы компонентов
В этом упражнении будет создана диаграмма Компонентов системы обработки заказов. На данный

момент уже определены все классы, требуемые для варианта использования "Ввести новый заказ". По мере
реализации других вариантов использования на диаграмму следует добавлять новые компоненты.
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Постановка задачи

Завершив анализ и проектирование системы, один из разработчиков проекта Дэн разработал диаграммы
Компонентов. Выбрав в качестве языка программирования С++, для каждого класса Дэн создал
соответствующие этому языку компоненты.

На рисунке 13 показана главная диаграмма Компонентов всей системы. Внимание на ней уделяется
пакетам создаваемых компонентов.

Рис. 13. Главная диаграмма Компонентов системы.

Рис. 14. Диаграмма Компонентов пакета Entities.

На рисунке 14 показаны все компоненты пакета Entities. Эти компоненты содержат классы пакета
Entities Логического представления системы.

На рисунке 15 показаны компоненты пакета Control. Они содержат классы пакета Control Логического
представления системы.
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Рис. 15. Диаграмма Компонентов пакета Control.
Наконец, на рисунке 16 показаны компоненты пакета Boundaries. Они также соответствуют классам

одноименного пакета Логического представления системы.
На рисунке 17 показаны все компоненты системы. Мы назвали эту диаграмму диаграммой Компонентов

системы. На ней вы можете видеть все зависимости между всеми компонентами проектируемой системы.

Рис. 16. Диаграмма Компонентов пакета Boundaries.
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Рис. 17. Диаграмма Компонентов системы.
Этапы выполнения упражнения
Создание пакетов компонентов
1. Щелкните правой кнопкой мыши на представлении компонентов в броузере.
2. В открывшемся меню выберите пункт New > Package (Создать > пакет).
3. Назовите этот пакет Entities (Сущности).
4. Повторите этапы с первого по третий, создав пакеты Boundaries (Границы) и Control (Управление).
Добавление пакетов на Главную диаграмму Компонентов
1. Откройте Главную диаграмму Компонентов, дважды щелкнув на ней.
2. Перетащите пакеты Entities, Boundary и Control из броузера на Главную диаграмму.
Рисование зависимостей между пакетами
1. На панели инструментов нажмите кнопку Dependency (Зависимость).
2. Щелкните мышью на упаковке Boundaries Главной диаграммы Компонентов.
3. Проведите линию зависимости до упаковки Control.
4. Повторите этапы 1 - 3, проведя еще зависимость от пакета Control до пакета Entities.
Добавление компонентов к пакетам и рисование зависимостей
1. Дважды щелкните мышью на пакете Entities Главной диаграммы Компонентов, открыв Главную
диаграмму Компонентов этого пакета.
2. На панели инструментов нажмите кнопку Package Specification (Спецификация пакета).
3. Поместите спецификацию пакета на диаграмму.
4. Введите имя спецификации пакета OrderItem.
5. Повторите этапы 2 - 4, добавив спецификацию пакета Order.
6. На панели инструментов нажмите кнопку Package Body (Тело пакета).
7. Поместите его на диаграмму.
8. Введите имя тела пакета OrderItem.
9. Повторите этапы 6 - 8, добавив тело пакета Order.
10. На панели инструментов нажмите кнопку Dependency (Зависимость).
11. Щелкните мышью на теле пакета OrderItem.
12. Проведите линию зависимости от него к спецификации пакета OrderItem.
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13. Повторите этапы 10 - 12, добавив линию зависимости между телом пакета Order и спецификацией
пакета Order.
14. Повторите этапы 10 - 12, добавив линию зависимости от спецификации пакета Order к спецификации
пакета OrderItem.
15. С помощью описанного метода создайте следующие компоненты и зависимости:
Для пакета Boundaries:

# Спецификацию пакета OrderOptions
# Тело пакета OrderOptions
# Спецификацию пакета OrderDetail
# Тело пакета OrderDetail

Зависимости в пакете Boundaries:
# От тела пакета OrderOptions до спецификации пакета OrderOptions
# От тела пакета OrderDetail до спецификации пакета OrderDetail
# От спецификации пакета OrderOptions до спецификации пакета OrderDetail

Для пакета Control:
# Спецификацию пакета OrderMgr
# Тело пакета OrderMgr
# Спецификацию пакета TransactionMgr
# Тело пакета TransactionMgr

Зависимости в пакете Control:
# От тела пакета OrderMgr до спецификации пакета OrderMgr
# От тела пакета TransactionMgr до спецификации пакета TransactionMgr
# От спецификации пакета OrderMgr до спецификации пакета TransactionMgr

Создание диаграммы Компонентов системы
1. Щелкните правой кнопкой мыши на представлении Компонентов в броузере.
2. В открывшемся меню выберите пункт New > Component Diagram
3. Назовите новую диаграмму System.
4. Дважды щелкните на этой диаграмме.
Размещение компонентов на диаграмме Компонентов системы
1. Если это еще не было сделано, разверните в броузере пакет компонентов Entities, чтобы открыть его.
2. Щелкните мышью на спецификации пакета Order в пакете компонентов Entities.
3. Перетащите эту спецификацию на диаграмму.
4. Повторите этапы 2 и 3, поместив на диаграмму спецификацию пакета OrderItem.
5. С помощью этого метода поместите на диаграмму следующие компоненты:
Из пакета компонентов Boundaries:

# Спецификацию пакета OrderOptions
# Спецификацию пакета OrderDetail

Из пакета компонентов Control:
# Спецификацию пакета OrderMgr
# Спецификацию пакета TransactionMgr

6. На панели инструментов нажмите кнопку Task Specification (Спецификация задачи).
7. Поместите спецификацию задачи на диаграмму и назовите ее OrderClientExe.
8. Повторите этапы 6 и 7 для спецификации задачи OrderServerExe.
Добавление оставшихся зависимостей на диаграмму Компонентов системы
Уже существующие зависимости будут автоматически показаны на диаграмме Компонентов системы после
добавления туда соответствующих компонентов. Теперь надо добавить остальные зависимости.
1. На панели инструментов нажмите кнопку Dependency (Зависимость).
2. Щелкните на спецификации пакета OrderDetail.
3. Проведите линию зависимости к спецификации пакета OrderMgr.
4. Повторите этапы 1 - 3, создав следующие зависимости:

# От спецификации пакета OrderMgr к спецификации пакета Order
# От спецификации пакета TransactionMgr к спецификации пакета OrderItem
# От спецификации пакета TransactionMgr к спецификации пакета Order
# От спецификации задачи OrderClientExe к спецификации пакета OrderOptions
# От спецификации задачи OrderServerExe к спецификации пакета OrderMgr
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Соотнесение классов с компонентами
1. В Логическом представлении броузера найдите класс Order пакета Entities.
2. Перетащите этот класс на спецификацию пакета компонента Order в представлении Компонентов
броузера. В результате класс Order будет соотнесен со спецификацией пакета компонента Order.
3. Перетащите класс Order на тело пакета компонента Order в представлении Компонентов броузера. В
результате класс Order будет соотнесен с телом пакета компонента Order.
4. Повторите этапы 1 - 3, соотнеся с классами следующие компоненты:

# Класс OrderItem со спецификацией пакета OrderItem
# Класс OrderItem с телом пакета OrderItem
# Класс OrderOptions со спецификацией пакета OrderOptions
# Класс OrderOptions с телом пакета OrderOptions
# Класс OrderDetail со спецификацией пакета OrderDetail
# Класс OrderDetail с телом пакета OrderDetail
# Класс OrderMgr со спецификацией пакета OrderMgr
# Класс OrderMgr с телом пакета OrderMgr
# Класс TransactionMgr со спецификацией пакета TransactionMgr
# Класс TransactionMgr с телом пакета TransactionMgr

Упражнение 8. Создание диаграммы размещения
В этом упражнении будет создана диаграмма Размещения для системы обработки заказов.

Постановка задачи
Команда разработчиков завершила весь предшествующий данному моменту анализ и проектирование

системы. Варианты использования, взаимодействия между объектами и компоненты четко описаны. Тем не
менее, подразделению администрирования сети необходимо знать, на каких компьютерах будут
размещаться различные компоненты системы. В связи с этим пришлось еще разработать диаграмму
Размещения для системы обработки заказов.
Создание диаграммы Размещения

Разработайте диаграмму Размещения для системы обработки заказов. Готовая диаграмма должна
выглядеть как на рисунке 18.
Этапы выполнения упражнения
Добавление узлов к диаграмме Размещения
1. Дважды щелкните мышью на представлении Размещения в броузере, чтобы открыть диаграмму
Размещения.
2. На панели инструментов нажмите кнопку Processor (Процессор).
3. Щелкните на диаграмме, поместив туда процессор.
4. Введите имя процессора "Сервер базы данных".
5. Повторите этапы 2 - 4, добавив следующие процессоры:

# Сервер приложения
# Клиентская рабочая станция №1
# Клиентская рабочая станция №2

6. На панели инструментов нажмите кнопку Device (Устройство).
7. Щелкните на диаграмме, поместив на нее устройство.
8. Назовите его "Принтер".
Добавление связей
1. На панели инструментов нажмите кнопку Connection (Связь).
2. Щелкните на процессоре "Сервер базы данных".
3. Проведите линию связи к процессору "Сервер приложения".
4. Повторите этапы 1 - 3, добавив следующие связи:

# От процессора "Сервер приложения" к процессору "Клиентская рабочая станция №1"
# От процессора "Сервер приложения" к процессору "Клиентская рабочая станция №2"
# От процессора "Сервер приложения" к устройству "Принтер"
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OrderServerExe

OrderClientExe ATMClientExe

Рис. 18. Диаграмма Размещения для системы обработки заказов.
Добавление процессов
1. Щелкните правой кнопкой мыши на процессоре "Сервер приложения" в броузере.
2. В открывшемся меню выберите пункт New > Process (Создать > Процесс).
3. Введите имя процесса OrderServerExe.
4. Повторите этапы 1 - 3, добавив еще процессы:

# На процессоре "Клиентская рабочая станция №1" -- процесс OrderClientExe
# На процессоре "Клиентская рабочая станция №2" -- процесс ATMClientEXE

Показ процессов на диаграмме
1. Щелкните правой кнопкой мыши на процессоре "Сервер приложения".
2. В открывшемся меню выберите пункт Show Processes (Показать процессы).
3. Повторите этапы 1 и 2, показав процессы на следующих процессорах:

# Клиентская рабочая станция №1
# Клиентская рабочая станция №2.

Упражнение 9. Генерация кода C++
В предыдущих упражнениях была создана модель для системы обработки заказов (Order Entry).

Теперь сгенерируем  программный  код  C++  для  этой системы.   При  этом  воспользуемся  диаграммой
Компонентов  системы, представленной на рисунке 19.  Для  генерации  программного  кода необходимо
выполнить  описанные  ниже  шаги.
Этапы выполнения упражнения
Ввод тел пакетов на диаграмму Компонентов системы
1. Откройте диаграмму Компонентов системы.
2. Выберите в броузере Entities: тело пакета Order.
3. "Перетащите" тело пакета Order на диаграмму Компонентов системы.
4. Повторите пп. 2 и 3 для следующих компонентов:

   Entities: тело пакета OrderItem.
   Boundaries: тело пакета OrderOptions.
   Boundaries: тело пакета OrderDetail.
   Control: тело пакета TransactionMgr.
   Control: тело пакета OrderMgr.
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Рис. 19. Диаграмма компонентов системы Order Entry
Установка языка C++
1. Откройте спецификацию компонента Order (спецификацию  пакета)  в пакете компонентов Entities.
2. Выберите в качестве языка C++.
3. Повторите пп. 1 и 2 для следующих компонентов:

   Entities: тело пакета Order.
   Entities: спецификация пакета OrderItem.
   Entities: тело пакета OrderItem.
   Boundaries: спецификация пакета OrderOptions.
   Boundaries: тело пакета OrderOptions.
   Boundaries: спецификация пакета OrderDetail.
   Boundaries: тело пакета OrderDetail.
   Control: спецификация пакета TransactionMgr.
   Control: тело пакета TransactionMgr.
   Control: спецификация пакета OrderMgr.
   Control: тело пакета OrderMgr.
   Спецификация задачи OrderClientExe.
   Спецификация задачи OrderServerExe.

Генерация программного кода C++
1. Откройте диаграмму Компонентов системы.
2. Выберите все объекты на диаграмме Компонентов системы.
3. Выберите Tools > C++ > Code Generation в меню.

Упражнение 10. Генерация Java-кода
Ранее была создана модель для системы обработки заказов (Order Entry). Теперь сгенерируем

программный код Java  для  этой системы.   При  этом  воспользуемся  диаграммой  компонентов  системы,
представленной на рисунке  20.
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Рис. 20. Диаграмма компонентов системы Order Entry

  Для  генерации программного кода необходимо  выполнить  описанные  ниже  шаги.
Этапы выполнения упражнения
Удаление тел пакетов
1. В упражнении 7 были созданы спецификации  и  тела  пакетов для  всех  классов.  Поскольку  тела
пакетов  в Java не используются, первым шагом является удаление их из модели.
2. Откройте спецификацию компонентов системы.
3. Выберите тело пакета OrderOptions.
4. Нажмите Ctrl+D, удалив тело пакета.
5. Повторите пп. 3 и 4 для следующих компонентов:

   Tело пакета OrderDetail.
   Тело пакета OrderMgr.
   Тело пакета Order.
   Тело пакета OrderItem.
   Тело пакета TransactionMgr.

Установка языка Java
Установка языка производится также как описано в упражнении 9. Отличие состоит лишь в том, что

вместо С++ устанавливается Java.
Импорт типов данных Java
1. Для  генерации  программного  код  Java  в  используемый файл модели необходимо включить типы
данных Java.  Эти  типы  содержатся  в каталоге  Data  Types  на  компакт-диске.  Откройте  главную
диаграмму классов.
2. Выберите File > Import в меню. Импортируйте файл Data Types\Java Classes.ptl с компакт-диска.
3. Откройте главную диаграмму Компонентов.
4. Выберите File > Import в меню. Импортируйте файл Data Types\Java Components.ptl с компакт-диска.
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Установка типов данных Java
1. Из-за того, что типы данных в Java именуются несколько иначе, чем в  C++,  теперь  нужно  установить
типы  данных  для всех атрибутов и операций так,  чтобы они стали достоверными типами.
ПРИМЕЧАНИЕ:  если все ранее предложенные упражнения выполнены,  то нужно только изменить тип
данных Date на java.util.Date.
2. Откройте диаграмму Add Order Class.
3. Установите типы данных для атрибутов, операций и аргументов, как показано на рисунке 21.

Рис. 21. Типы данных Java для классов Order Entry
Генерация программного кода Java
1. Откройте диаграмму Компонентов системы.
2. Выберите все объекты на диаграмме.
3. Выберите  Tools  >  Java  >  Generate Java в меню.  Генерируемый программный код Java должен
выглядеть так,  как текст упражнения для этой главы на вспомогательном компакт-диске.

Упражнение 11. Генерация IDL-кода
Сгенерируем программный код IDL для некоторых классов системы обработки заказов (Order Entry):

Order, OrderItem, TransactionMgr и OrderMgr. Для генерации программного кода IDL необходимо
выполнить описанные  ниже шаги. Программный код этого упражнения содержится на компакт-диске.
Этапы выполнения упражнения
Установка стереотипов CORBA
1. Откройте диаграмму Add Order Class.
2. Откройте окно стандартной спецификации класса Order.
3. Установите для класса Order стереотип interface.
Установка имен ролей
Для   каждой связи   на   диаграмме  откройте  окно спецификации. Создайте имена ролей на обоих концах
связи.
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Создание компонентов
1. В упражнении 7 были созданы компоненты,  причем языком  по  умолчанию был  C++.  Теперь  нужно
установить компоненты CORBA.  Первый этап -- удаление старых компонентов, которые больше не
нужны.
2. Откройте главную диаграмму компонентов.
3. Выберите все элементы на диаграмме и нажмите Ctrl+D, удалив их.
4. С помощью кнопки Component панели инструментов  создайте  четыре новых компонента: Order,
OrderItem, TransactionMgr и OrderMgr.
5. Откройте окно спецификации компонента Order.
6. Установите язык компонента как CORBA.
7. В броузере "перетащите"  класс Order из логического представления в компонент Order компонентного
представления.
8. Повторите пп. 5-7, отобразив классы OrderItem, TransactionMgr и OrderMgr   на   соответствующие
компоненты   и  установив  для  всех компонентов язык CORBA.
Установка типов данных CORBA
1. Откройте окно спецификации атрибута OrderNumber класса Order.
2. Выберите кнопку "..." рядом с полем Type в окне спецификации.
3. Выберите знак + рядом с CORBA Types в иерархической структуре.
4. Выберите Long в списке классов.
5. Повторите пп.  1-4 для всех атрибутов классов Order,  OrderItem, OrderMgr и TransactionMgr, отобразив
каждый атрибут на соответствующий тип CORBA.
6. Откройте окно спецификации операции SetInfo класса Order.
7. Выберите кнопку "..." рядом с полем Return в окне спецификации.
8. Выберите знак + рядом с CORBA Types в иерархической структуре.
9. Выберите boolean в списке классов.
10. Дважды щелкните мышью на аргументе Integer  OrderNum  в  списке аргументов.
11. В  этом  окне  спецификации  щелкните  мышью на знаке + рядом с CORBA Types  в  иерархической
структуре  и  выберите  long  в  списке классов.
12. Повторите  пп.  6-11  для  всех  операций  и аргументов классов Order, OrderItem, OrderMgr и
TransactionMgr.
Генерация программного кода CORBA/IDL
1. Откройте диаграмму Add Order Class.
2. Выберите классы Order, OrderItem, TransactionMgr и OrderMgr.
3. Выберите Tools > CORBA > Generate CORBA. В ответ на предложение отобразите   компоненты   на
каталог, добавленный ранее в окне спецификации проекта. Генерируемый при этом программный   код
представлен на компакт-диске.


